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INSTALLATION GUIDE 
 
 
1. INSTALLATION & SETUP 
 
 
1.1 Technical Specification 

 
The part number for Access 3000 Server is: A3NS  

 
 
1.1.1 Paging Client Functions 

 
� User, team, set and group paging 
� Group create, edit and delete 
� Search functions 
� Call scheduler 

 
 

1.1.2 Management Client Functions 
 

� User, team, set and group create, edit and delete 
� Operator create, edit, and delete 
� Operator access rights administration and password control 
� User, team, set and group paging 
� DLC create, edit and delete 
� CFA message edit 
� Wide area dial-out configuration for Paging and TAP messaging 
� Call logging of all paging messages 
� Call log analysis 
� Server event log monitoring 
� Connection summary 
� Client status 
� Logging, archiving and Access 3000 configuration 
� Help information - Acrobat document 
 

 
1.1.3 Engineering Client Functions 
 

� Connection summary 
� Client status 
� Operator status 
� Server event log 
� Server database back-up and restore 
� Access 3000 bus monitor 
� Access 3000 link monitor 
� Access 3000 monitoring online 
� Access 3000 database restore 
� Online and offline operation 
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1.2 Product Overview 
 

Access 3000 Server is a software package connecting your Access 3000 
paging system to the PC network.  It enables you to send text and numeric 
messages plus schedule calls from your computer to pagers and mobile 
phones.  In addition Access 3000 Server also includes a networked version of 
Management Terminal for WindowsTM, allowing you to manage the Access 
3000 paging system from your desktop PC.  
 
The Access 3000 Server runs on a PC and this is connected to Access 3000 
Paging system via the C3EK Encoder or the C3CB System Master.  The 
server PC is also connected to customer’s Local Area Network (LAN) using a 
standard network card. 
 
Apart from installing the server on a computer, the actual management of the 
Server is undertaken via the Management and Engineering Clients.  The 
Engineering Client provides database backup, reconfiguration and restore.  
The Management Client is used for day-to-day administration in terms of 
creating and editing operators, determining individual access rights and 
password control. 
 

 
 
 System Schematic 

Access 3000 
Paging System 

Access 3000 Server 

RS232 

 
TCP/IP 

Local Area 
Network 

Management Terminal 
Access via the PC Network 

Multiple 
Paging 
Users 

Multiple 
Paging 
Users 

Engineering 
Clients
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1.3 System Requirements 
 
The Access 3000 Server Suite is a Client/Server based system designed 
primarily for Microsoft Windows versions 2000, XP and NT4*.  This software 
comprises a server program, A3kServer, that runs as a Windows service and 
three Windows-based client applications: A3kPageClient, A3kManClient and 
A3kEngClient.  These clients additionally support Windows 98 and ME and 
communicate with the server via a network connection. 
 
Recommended minimum Server system requirements are: 

 
� Microsoft Windows 2000 SP2, XP and NT4 SP6 with Microsoft Internet 

Explorer 5.5 or Later. 
 

� 500MHz Processor 
 

� 128MB RAM 
 

� 55MB disk space for the core software itself and a further 20MB (or more 
depending on database sizes) for database and logs. 

 
Minimum client system requirements are: 

 
� Microsoft Windows 2000 SP2 or later, XP and NT4 SP6 with Microsoft 

Internet Explorer 5.5 or Later.  Windows 98 or ME with Microsoft Internet 
Explorer 5.01 or later. 

 
� 500MHz Processor 

 
� 64MB RAM 

 
Up to 15MB disk space for the clients themselves and a further 20MB for the 
management client (or more depending on database sizes) for cached data. 

 
Note:  Access 3000 Server fully supports NT4 please note that Windows NT is 
no longer a Microsoft supported platform. 
 

 
 

 
 
 



9261-7625 Issue 1 Page 11 

1.3 Installation 
 

A computer user with administrator privileges must perform installation.  The 
system is provided on a single CD-ROM containing the server and the three 
clients.  Inserting the CD-ROM into a suitable drive should begin the 
installation process.  If this does not happen, installation can be started 
manually by running the file ‘setup.exe’ located in the root directory of the CD-
ROM. 
 
Note: Windows 98 does not include the Windows Installer application by 
default (unlike Windows 2000, XP and ME).  When installing on such a system 
the program will first attempt to install the Windows Installer (unless it is 
already present).  This may involve an automatic re-boot of the system; 
Access 3000 Server Suite installation will continue after login following the re-
boot. 
 
Software installation follows the standard Windows Installer operation, 
prompting for install location, license acceptance etc.  The installation program 
provides an option enabling the selection of which parts of the system to install 
(server, clients).  A full installation installs all applications on a 2000, XP or NT 
machine, and only the clients, on a Windows 98/ME machine.  The exact 
items installed can be selected via the custom install option. 

 
 
1.3.1 Installing the Server 
 

In the Setup Type dialog box click Complete/Custom then click Next to 
proceed, from the Custom Setup dialog box click Access 3000 Server Suite 
then click Next to proceed.  This will install the Server the Management 
Terminal, Paging and Engineering Clients. 

 
 

Setup Type Dialog Box 

 

Custom Setup Dialog Box 

 
 
 
Alternatively, if you wish to install the server only from the Setup Type dialog 
box click Complete/Custom.  From the Custom Setup dialog box click 
Access 3000 Server then click Next to proceed. 
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1.3.2 Installing the Clients 
 

To install the client software, go to the required networked PC and run the 
install CD-ROM.  From the Setup Type dialog box click: 
 
� All Clients if you require the Management Terminal, Paging Client and 

Engineering clients to run on a single machine 
 
� Paging Only if the paging client is required – For most PCs. 
 
� Complete/Custom from the Custom Setup box click the required client 

e.g. the Management Client, Engineering Client or Paging Client. 
    
 
1.3.3 Completing the Installation Process 
 

Towards the end of the process, the ‘A3k Client Configuration’ dialog box will 
be displayed (see below) requesting the entry of server connection and client 
details for the install machine.  Enter the address (or name) of the machine 
running the A3k Server, and the TCP/IP port number on which the server is 
listening (configured on the server itself), and enter a short description for this 
particular client machine, for example ‘Paging Station 42’.  This description will 
be used to identify the location of a particular client in addition to its network 
address. 
 
Note: These settings can be changed at any time by running the following 
command line from Windows Explorer:  Program Files\Multitone\Access 
3000\Bin\A3kClientCfg.exe, or running any client application with the /config 
command-line switch appended, e.g. Program Files\Multitone\Access 
3000\Bin\A3kPageClient /config 
 

 
 

 
Once installation is completed, an ‘Access 3000 Server Suite’ entry will have 
been added to the ‘Programs’ menu containing shortcuts to all the installed 
client applications.  If server installation is selected the new Windows service 
(‘A3kServer’) will be created and started automatically.  It is recommended 
that after installation, the service configuration be reviewed using the Windows 
service manager tool.  In particular, setting the service ‘Recovery’ options to 
re-start the service automatically should it fail. 
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Documentation is provided in Portable Document Format (pdf).  If the system 
does not have a suitable pdf file reader installed (such as Adobe Acrobat 
Reader), a copy of Adobe Acrobat Reader is supplied within the ‘Acrobat’ 
directory of the CD-ROM; run the executable in the Acrobat directory and 
follow the on-screen instructions (Administrator access is required to run the 
Acrobat installation program). 
 
Note: To setup the system database, at least one Management Client 
(A3kManClient) must be installed. 

 
 
1.4 Unattended (Silent) Installation 
 

To enable the rapid installation of a large number of paging clients, an 
unattended (or silent) installation can be performed as follows: 
 
� Copy of the contents of the installation CDROM to a suitable location 

(probably a network share for remote installations). 
 
� Edit the copied A3kClientCfg.ini file entering the required A3k Server 

machine details, and un-commenting the appropriate lines (see 
A3kClientCfg.ini for details).  This will bypass the manual A3k client 
configuration step (described above). 

 
� Run the setup from the command-line (or a suitable alternative), using the 

/v/qn switch, i.e. ‘setup.exe /v/qn’ (with no space after the /v).  Paging client 
installation will then proceed without any manual intervention. 
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1.5 Client Licence Authorisation Codes  
 

Having installed the software you will now need to generate a Client License 
Authorisation Code.   

 
1. Now look for the Multitone  icon in the system tray (bottom left of task 

bar).  Right click and select Open A3K Server Manager and note down 
the Server ID Code, for example: kudd-u3k5-lr.  

 

 
 
 

2. Determines the number of Management Terminal, Paging and Engineering 
clients you require plus Call Scheduling.  You will now be required to enter 
the Authorisation Code.  This code may be obtained from Customer 
Service at King’s Lynn by supplying full customer details and quoting the 
Server ID Code e.g. kudd-u3k5-lr.    

 
Note: The system will always be supplied with 1 free Engineering Licence. 
 

3. From now on the Sever will start automatically whenever anyone logs into 
the system.  If more licences are required a new Authorisation Code will be 
required. 
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1.6 Database Set-up 
 

 Having installed the Server you now need to determine the Access 3000 
database back-up parameters: 
 
� Database Back-up – Archiving, storage criteria and location of the Access 

3000 server database. 
 
� Event Log - Stores all the transactions between the clients, server and 

Access 3000 system.  
 
� Call Log Purge - Stores all the calls made by the Access 3000 system.   

 
� Access 3000 Serial Link - Please note that configuration of the Access 

3000 serial link can only be undertaken from the Management Client 
running on the Server. 

 
It is advised that these are set-up via the Management Client running on the 
Server.  Please see Section 12 in the Management Terminal section of the 
User & Supervisors Guide. 
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1.7 Frequently Asked Questions 
 
 
1.7.1 What Database Does Access 3000 Server Run-on? 
 

Access 3000 Server uses Microsoft SQL Server Desktop Edition (MSDE) 
2000 (Service Pack 3a) for data storage.  In order to ensure that there are no 
licensing issues Multitone Electronics PLC has checked with Microsoft that 
under the developers licence Multitone Electronics PLC are licensed to freely 
supply this as part of the product.  Furthermore, as it is fully integrated into 
Access 3000 Server there is no requirement for the customer to download or 
install it. Note that the clients communicate with the Access 3000 Server only, 
and not directly with MSDE. MSDE only talks locally to the server, and is not 
required to provide any external access. 
 
 

1.7.2 How Does Access 3000 Server Operate? 
 

Access 3000 Server runs over TCP/IP, and communicates with the clients 
using a proprietary protocol. All communications are authorised by the server 
using a suitable operator ID and password, and the server itself provides no 
ability to run external scripts, or give direct access to machine resources. 
 
From an operation perspective, on connection, a client downloads the core 
data it requires from the server.  This generally takes only a few seconds over 
a LAN or broadband link depending on the number of records in the database: 
the Paging Client is a ‘light client’, taking 1 to 2 seconds, whereas the 
Management Client also downloads the server event log and call log, and 
usually requires 3 to 4 seconds (the Engineering Client downloads the event 
log but not the call log). 
 
These logs can grow to be several tens of megabytes in size depending on 
the size of the system and current database archiving and purging options.  To 
minimise start-up time, the full logs are only downloaded when a client 
connects to the server for the first time from a particular client machine – they 
are then cached locally so that next time the client starts, only the changes 
since it was last closed are downloaded.  Once connected to the server, a 
client is only notified of updates to the system, typically time updates and new 
log entries. 
 
Note that during initial download of a large call or event log, the Management 
Client can still be used for database editing, options changing etc. The 
download will continue in the background.  If the client is closed during the 
download, when it is next started it will resume from where it left off. 
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1.7.3 What Happens if the Server Disk Drive Fails? 
 

In order to overcome any disk failure concerns, Multitone Electronics PLC 
suggest running on a fault-tolerant server incorporating a RAID array.  The 
server can also be configured to automatically make period backups of the 
entire database to a separate file. 

 
 
1.7.4 Can the Server Backup the Database to Network Share? 
 

By default the Access 3000 server will periodically backup the database to the 
system drive on the server machine. The backup location can be set to any 
directory accessible from the server using the Management Client, however, 
to backup to a network share, the MSDE database engine must have read and 
write access to that share. MSDE is a service (“MSSQL$ACCESS3000”) 
running, by default, under the local System account, which does not generally 
have access to a remote machine.  This can be changed to use a suitable 
account with the required network access via the Windows Service Control 
Manager – it is recommended that a special Access 3000 account (with local 
Administrator rights) be setup for this purpose alone. 

 
 
1.7.5 What are the Options Should the Server Fail? 
 

If a server outage is to be avoided, Multitone Electronics PLC advise the 
deployment of a hot standby system - a second server with a second 
authorisation code will be required.  You can then use management tools 
within Windows to periodically and automatically copy the database across.  
 
Secondly, Access 3000 Server is an adjunct system, should the server fail the 
Access 3000 paging system will NOT be effected, paging calls can still be 
undertaken from the Local Control Unit (LCU) or via the telephone interface 
via a PABX.    
 
Thirdly, an uninterrupted power supply (UPS) could be used to protect the 
Server PC from power failure.  

 
 
1.7.6 What Happens as a Result of a Server Re-start? 

 
Access 3000 Server runs in the background (as a Windows Service) and will 
automatically re-start if Windows crashes. It will then silently re-synchronise 
itself with the Access 3000 paging system so that any changes made to the 
paging system (via an LCU for example), will be mirrored on the server. 
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1.7.7 Does the Server Time Synchronise? 
 

Access 3000 will take its time from the Server; this applies to pager time 
stamping and call logging etc.  This facility enables the Server to synchronise 
with a timeserver, if required. 
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ENGINEERING CLIENT 
 
 

1. A QUICK GUIDE TO THE ENGINEERING CLIENT 
 

The Engineering Client is used primarily as an engineering tool for system 
monitoring and database backup, features supported are: 

 
� Connection summary 
� Clients Status 
� Operator Status 
� Event Log 
� Server database back-up and restore 
� Access 3000 Bus Monitor 
� Access 3000 Link Monitor 
� Access 3000 monitoring online 
� Access 3000 database restore 
� Online and offline operation 
 
Since this is a networked system, multiple Engineering Clients can be run to 
provide remote Access 3000 monitoring 
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2. HOW TO ACCESS THE ENGINEERING CLIENT 
 

 
2.1 Opening the Engineering Client 

 
1. Click the Start button  
 
2. Click Programs, click Access 3000 Sever Suite, click Engineering 

Client: 
 

 
 

3. Select your Operator ID from the list, if activated enter the Password and 
click Login: 

 

 
 
4. The Engineering Client will now be displayed showing the Connection 

Summary: 
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2.2 Changing Passwords 
 

1. From the File Menu click Change Password 
 
2. Enter the current password, then enter the new password, then confirm the 

new password and click OK.  When you log you will now have to enter the 
password as part of the log-on sequence: 

 

 
 

Note: 
 
If you wish to remove password protection, then leave the ‘Enter New 
Password’ and ‘Confirm New Password’ boxes blank.  Click ‘OK’ to confirm 
the selection.   
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2.3 Engineering Client - Logging Off and Exit 
 
 
2.3.1 Logging Off 
 

1. From the File Menu click Log Out.  
 

2. You will now be asked to confirm the action, select Yes or No. 
 

3. At the Login Screen you may login under an alternative ID. 
 

 
 
 
2.3.2 Exiting the Engineering Client 
 

1. From the File Menu click Exit.  
 
2. You will now be asked to confirm the action, select Yes or No. 
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3. SYSTEM MONITORING 
 

The system monitoring functions are used to help you to determine the status 
of both Access 3000 and Access 3000 Server in terms of connectivity and 
system activity, key reporting tools are: 

 
� Connection summary 
� Client status 
� Operator status 
� Server event log 
� Access 3000 bus monitor 
� Access 3000 link monitor 

 
 
3.1 Connection Summary 

 
The Connection summary provides details of client set-up, current 
connections, current server details, and Access 3000 status.  The Connection 
Summary is view only, 
 
1. From the View Menu click Connection Summary: 
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3.2 Client Status 
 

To view the status of all client programs currently connected to the server, 
from the View Menu click Clients: 

 

 
 

 
Access 3000 Server comprises the server and a number of licences.  These 
are available for 10, 50, 100 and 250+ concurrent client users. 
 
There are two client types in addition to the Engineering Client: the Paging 
Client, allowing you to make paging calls from your PC and the Management 
Client for system administration.  When ordering Access 3000 server you can 
choose the number of Paging Clients and Management Clients.  For example 
if you order 10 licences you can have 2 Management Clients and 8 Paging 
Clients.  Every system is supplied with an Engineering Client; this is used for 
database control and server management. 
 
Additionally, extra licences may be ordered if you wish to add more users to 
the Access 3000 Server solution:  
 
� A3NS-CP10   10 Additional Client Licences 
� A3NS-CP50   50 Additional Client Licences 
� A3NS-CP100 100 Additional Client Licences 
� A3NS-CP250 250 Additional Client Licences 

 
There is no restriction on the number of individual Paging, Management or 
Engineering Clients which may be requested provided they equal the number 
of licences ordered.  For example if you order A3NS-CP10, 10 licences you 
may have 3 Management Terminal Clients and 6 Paging Clients and 1 
additional Engineering Client. 
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3.3 Operator Status 
 
Operators and clients can be confusing terms; the client is the program 
running on the remote machine, this can be the Paging Client, Management 
Client or Engineering Client.  The Operator is the person who logs into the 
client.  The Operator Summary gives detail of the operators, access rights, full 
name and general details, along with their current login status. 
 
In order to view the status of all operators, from the View Menu click 
Operators, the operator status will be displayed: 
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3.4 Event Log 
 

The server event log displays all the activity between the Access 3000, 
Access 3000 Server and the Clients.  The Event Log is view only, however, it 
is colour coded.  To view the Event Log from the View Menu click Event Log: 
 

 
 
 

The event log window lists the contents of the server event log, in 
chronological order.   Each event record contains a number of fields: 

 
Field Name Description 
Event Number Unique, incrementing event ID number. Auto-generated. 
Type Describes the general type/source of the event, e.g. 

database, server, paging. 
 

Sub-type Event sub-type of the event, e.g. page user event, 
operator login. 
 

Time Server date/time at which the event occurred. 
 

Group For multiple-event operations, such as A3k database 
synchronisation or group paging, group specifies the 
event number of the event describing the start of the 
operation. 
 

Details Readable description of the event itself 
 

Extended Data Type/sub-type specific data incorporated into the details 
description. Useful for external database analysis. 
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There are currently 16 event types supported, each being displayed using a 
different colour.  The currently supported event types are: 

 
Type 

(numbers) Description Colour 
Global database operations (e.g. database 
open/close). 
 

Green 

Database record operations. 
 

Normal (white)

Database 
(1-3) 

Database errors. 
 

Red 

Global server events (e.g. server started). 
 

Blue-Grey 

Server operations (e.g. operator logged-in, client 
connected). 
 

Blue-Grey 

Server 
(4-6) 

Server errors. 
 

Red 

Paging events for pages sent from the server. 
 

Light Green Page 
(7, 8) 

Paging error events. 
 

Red 

Access 3000 synchronisation (during initial 
connection) events. 
 

Light Purple A3k Sync 
(9, 10) 

Access 3000 synchronisation (backup) errors. 
 

Red 

Access 3000 notifications – Asynchronous 
database updates from the Access 3000. 
 

Orange/YellowA3k Notify  
(11, 12) 

Access 3000 notification errors. 
 

Red 

Access 3000 database restore events. 
 

Light blue A3k Restore 
(13, 14) 

Access 3000 database restore errors. 
 

Red 

Database a3k configuration (SSF) update events 
(during initial connection). 
 

Purple Config Update 
(15, 16) 

Database a3k configuration (SSF) update errors. 
 

Red 
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3.5 Bus Monitor 
 

This displays the paging system bus traffic between Access 3000 Server and 
the paging system serial link, each packet is broken down into its constituent 
components. 

 
 
3.6 Link Monitor 

 
This displays the raw paging system bus traffic including all control codes. 
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4. DATABASE MAINTENANCE 
 

The Engineering Client provides a range of facilities, which enable re-
synchronise Access 3000 and Access 3000 Server databases. 
Synchronisation problems may result from offline paging system operation, 
changes in paging system SSF configuration or implementation of new 
software upgrades.  Features supported are:   
 
� Server database back-up and restore 
� Access 3000 database restore 
� Online and offline operation 

 
 
4.1 Backup Server Database 
 

Access 3000 Server will automatically back-up the Server Database in 
accordance with configured options.  See Section 12, Database Management, 
Sub-Section 12.1 for full details.  It is also possible to back-up the Server 
Database manually, as follows: 
 
1. From the Server Menu click Server Backup. 
 
2. At the dialogue box click Yes to continue.   
 
3. Enter a brief description or summary information. 
 
4. Then click OK. 
 
The file will be stored in the configured Database Backup directory, which, by 
default, is set to C:\Documents and Settings\All Users\Application 
Data\Multitone\Access3000\Backups. This can be viewed and changed via 
the Management Client (see later). 
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4.2 Restore Server Database 
 

This operation allows a previous backup of the server’s database to be 
selected and installed, in place of the current server database.  Please note 
that this does not affect the paging system’s core database (UTU). 
 
1. From the Server Menu click A3k Offline.   Refer to the Connection 

Summary to confirm the Access 3000 link status as A3k forced off-line. 
 
2. From the Server Menu click Restore Server Database.  From the 

dialogue box click Yes to continue. 
 

3. From the Select Server Backup list highlight the Database Backup File 
you wish to restore: 

 

 
 
 

4. Click the Restore button, the following dialogue boxes will be displayed 
confirming database restoration: 

 

 
 

 
 
 

5. Once the database has been restored, from the Server Menu click A3k 
Reconnect.  From the dialogue box click Yes to continue.  Now refer to 
the Connection Summary to confirm Access 3000 link status as A3k 
online. 

 
Note:  Once the restore has completed successfully, all clients currently 
connected to the system will be completely re-synchronised with the 
Server.  Any operator currently logged-in will, however, remain logged-in. 
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4.3 A3K Database Restore 
 

In most normal circumstances this facility is not required as it is done as the 
paging database updated automatically.  This facility copies the Access 3000 
Server paging database onto the paging system and overwrites existing 
paging system records.  To perform a restore the paging system must be 
offline: 
 
1. From the Server Menu click A3k Offline.  Refer to the Connection 

Summary to confirm the Access 3000 link status as A3k forced off-line. 
 

2. Return to the Server Menu and click A3k Database Restore to start the 
process. 

 
3. Once the database has been restored, from the Server Menu click A3k 

Reconnect.  Refer to the Connection Summary to confirm Access 3000 
link status as A3K online. 

 
 
4.4 Abort A3K Operation 

 
Please note, this may be used to halt an Access 3000 database restore, but 
this will leave the paging system UTU only partially loaded. 
 
1. From the Server Menu click A3k Abort Operation. 
 
2. At the dialogue box click Yes to continue. 
 
3. Look at the Connection Summary to confirm Access 3000 link status as 

A3K Forced Offline. 
 

4. To restore operation, from the Server Menu click A3k Reconnect.  Look 
at the Connection Summary to confirm that the Access 3000 link status 
as A3K online. 

 



9261-7625 Issue 1 Page 32 

MANAGEMENT CLIENT 
 
 
1. A QUICK GUIDE TO THE MANAGEMENT CLIENT 
 

The Management Client supports all Access 3000 administrative features and 
has the same interface as the standalone Management Terminal for Windows 
TM.  It also includes the capability to create and edit paging operators and 
management elements of the Access 3000 Sever.  Features include: 

 
� User, team, set and group create, edit and delete 
� User, team, set and group paging 
� DLC create, edit and delete 
� CFA message edit 
� Wide area dial-out configuration for Paging and TAP messaging 
� Call logger configuration 
� Call logging of all paging messages 
� Call log analysis 
� Client status 
� Logging, archiving and Access 3000 configuration 
� Server event log monitoring 
� Operator - create, edit and delete. 
� Operator access rights administrator and password control 
� Help information - Acrobat document 
 
 
Full System Management From the Desktop 
 
For system management, call logging and statistical analysis, the 
Management Client provides on-screen management of all Access 3000 
system records.  This includes, users, teams, sets and groups (system or 
personal), closing contacts, pre-set messages and the wide area dialout 
facility for public carrier paging and messaging. 
 
In addition to the paging system management features the Management Client 
also enables you to create new operators (the people who log on to the 
client/server system itself – analogous to Windows users) set passwords and 
determine individual access rights, giving you complete system management 
of both the Paging System and the Access 3000 Server. 

 
 

Full Paging & Call Logging Facilities 
 

The Management Client includes the ability to make paging calls and 
incorporates full call logging facilities - automatically recording the time and 
date when all paging calls are transmitted.  Also included is a wide range of 
tools for statistical analysis, allowing you to analyse call counts, call times, 
type-of-paging-calls, pager usage and system faults etc. 

 
 



9261-7625 Issue 1 Page 33 

Multi-Tasking - System Management Operations 
 

As this facility is networked you can operate multiple Management Clients 
simultaneously.  For example one person can be adding or editing paging 
records, whilst another can access the call logger to check the time a paging 
call was sent.  At the same time a third operator can send a paging message, 
make a team call or alter another user record. 
 
 
Password Protection & Client Access Control 

 
In order to maintain server security, password protected access rights are 
provided.  This enables the system supervisor or network manager to 
determine what level of access an individual operator may have.  For example 
you might not want to give some operators the ability to send a team call, nor 
would you want everyone to have access to the system management 
functions. 
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1.1 Opening the Management Client 
 
1. Click the Start button:  
 
2. Click Programs, click Access 3000 Sever Suite, click Management 

Client: 
 

 
 

3. Select your Operator ID from the list, if activated enter the password and 
click login: 

 

 
 
4. The Management Client will now be displayed showing the Connection 

Summary: 
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1.2 Changing Passwords 
 

1. From the File Menu click Change Password 
 
2. Enter the current password, then enter the new password, then confirm the 

new password and click OK.  When you log you will now have to enter the 
password as part of the log-on sequence. 

 

 
 

Note:  If you wish to remove password protection, then leave the ‘Enter 
New Password’ and ‘Confirm New Password’ boxes blank.  Click ‘OK’ to 
confirm the selection.   
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1.3 Management Client – Logging Off and Exit 
 
 
1.3.1 Logging Off 
 

1. From the File Menu click Log Out.  
 
2. You will now be asked to confirm the action, select Yes or No. 

 
3. At the Login Screen you may log-in under an alternative ID: 
 

 
 
 
1.3.2 Exiting the Management Client 

 
1. From the File Menu click Exit.  
 
2. You will now be asked to confirm the action, select Yes or No. 
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1.4 A Tour of Management Client 
 
The Management Client is based around a single main application window 
split into a number of sub-windows.  The layout and display of these windows 
can be customised according to user preference and available screen space.  
The example below shows a typical screen shot including a set of toolbars and 
the main record selection and edit windows, along with the navigator: 
 

 
 
 
1.4.1 The Main Window 

 
In the screen-shot above, the Main Window or in this case the User Database 
is broken down into two sections.  The top window displays all the users on 
the system, while the bottom window shows details of each user and enables 
you to edit individual user record details.  The information displayed in the 
main window also covers the following records: 
 
� Connection Summary 
� Client Connection Details 
� Operators 
� Server Configuration Options 
� Server Event Log 
� Database Summary 
� User Database 
� Team Database 

� Set Database 
� Group Database 
� Scheduled Call Overview 
� Paging System Configuration 
� DLC Record Database 
� CFA Message Database 
� WAD Database 
� Call Log Configuration 

 
 
 
 



9261-7625 Issue 1 Page 38 

1.4.2 Navigation 
 

A number of alternative methods may be used to navigate around the 
Management Client: 
 
� Select the appropriate menu item using from the standard toolbar.  For 

example: 
 

1. From the main toolbar select View 
 
2. Then select Teams 

 
This will display the Team Database.  All the instructions in this user guide 
use where possible this method to navigate around the Management 
Client.  Although this is slightly long winded, this method of navigation will 
always remain consistent, however the windows are set-up.  
 

� Alternatively you can: 
 
� press a button on the ‘Standard’ and Navigate’ toolbars.  For example, 

the Configuration icon ( ) changes the main window to a single view 
showing paging system parameters, receivers and channels etc. 

 
� select a ‘shortcut’ from the ‘Shortcuts’ bar in the ‘Navigator’ window. 
 
� select an item from the ‘Navigator’ tree in the ‘Navigator’ window. 

 
 
1.4.3 Other Windows 
 

In addition to the main window, there are further windows available.  These 
are all implemented as docking windows and can be made visible via the 
appropriate view menu item: 
 
� Navigator - docked onto the left-hand side of the main window by default, 

this provides the primary means of navigating around the entire system. 
 

� Paging Console - a floating window allowing users and teams to be paged. 
 
� Activity Log - A floating window showing the last 5,000 operations 

performed by Management Client on the paging system database (and 
vice-versa) – this is effectively a subset of the server event log, which 
shows the operations of all clients. 
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1.4.4 Status Bar 
 

The status bar is located at the bottom of the Management Client window, and 
shows the status of various system and Management Client parameters: 

 
 
 
From left to right these are: 
 
� Paging error report - View the activity log or the server event log for more 

information on the error.  Double click on the error report to clear it. 
 
� Paging system faulty state - This field is red if there is a fault or device not 

working on the Access 3000, green if it’s healthy and blank if the system is 
offline. 

 
� Client connection and log-on status - Indicates whether the paging system 

is on line (green) or off line (red).  Also shows initialisation progress when 
Management Client is going online. 

 
� Server and paging system time - the Access 3000 internal clock is 

automatically synchronised to the server PC. 
 
 
1.5 Customisation 
 

The appearance and behaviour of many of the Management Client windows 
and toolbars can be customised in a number of ways: 
 
 

1.5.1 Toolbars 
 

As with other Windows applications, the toolbars can be moved around, 
hidden or resized and the toolbar button text can be hidden to make more 
efficient use of a small screen.  To show or hide a toolbar: 
 
1. From the main toolbar select View. 
 
2. Select Toolbars. Click-on the boxes to show and hide toolbars and toolbar 

label text 
 
 
 
 
 
 
 
 



9261-7625 Issue 1 Page 40 

1.5.2 Main Window Settings 
 

The main windows are based on a grid-style list of items.  These provide a 
number of customisation options: 

 
� Columns can be re-ordered by dragging a column header to the desired 

position using the left mouse button. 
 

� In most views, data can be sorted to be numerically or alphabetically 
ascending or descending by clicking-on the appropriate column header. 
Note: this is not possible for the call or event logs. 

 
� Columns may be resized by dragging the column separators within the 

column header.  To hide a column it can simply be shrunk until it is no 
longer visible.   

 
Please note that the lists used for Team, Set and Group Databases and WAD 
Service windows are hierarchical, incorporating a tree-based column that can 
be used to expand or collapse sub-items, e.g. teams and team members.  All 
of the above features are also available in these views. 
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1.6 Printing 
 
 
1.6.1 General Printing  
 

The contents of most of the windows and views within Management Client 
may be printed onto any attached or networked printer.  To print or preview 
the contents of a window, select an item in the desired view, e.g. the User 
Database, or a Call Log Query, then: 

 
1. Click File Menu and select Print or Print Preview menu option, or 
 
2. Click on the Print ( ) or Preview ( ) button on the standard toolbar, or 

 
3. Press Ctrl+P (to print only). 

 
The appearance of the printed page may be customised using the Print Set-up 
dialog box.  This accessed via: 
 
a. Click File Menu then select Print Set-up, or 
 
b. Click-on the Set-up toolbar button ( ) when in print preview mode: 
 

 
 
 
This dialog box provides standard options to select printer, paper size and 
orientation etc, along with further options for customising the margins, headers 
and footers and fonts of the output page. 
 
Note:  The print layout matches the default screen layout only and does not 
take account of local changes to the current view.  For example, columns that 
are switched on the screen view are NOT switched on the printout. 
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1.6.2 Printing Individual Record Details 
 

It is possible to print individual record details of a client operator, user, team 
set, group or scheduled call.  This application also applies to live call log 
records. 
 
1. Select the appropriate records database, e.g. User Database: 

 

 
 
 
2. Click anywhere in the User Details window to select it. 
 
3. From the File Menu click Print to print the record or Print Preview to 

display the record: 
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2. OVERVIEW OF DATABASE EDITING 
 
This section provides an overview of how to view, create and edit the main 
paging system databases.  The Management Client database is split into five 
key sections: 
 
� Operators 
� Users 
� Teams 
� Sets 
� Groups 
� DLCs 
� CFA Messages 
� Wide Area Dial-out (or WAD) Services 
 
Viewing and editing each of these sections follows the same general process, 
with the Window being split into two sections: 

 
� The top window lists all the entries such as users and teams within the 

database 
 
� The bottom window displays the individual details connected with an entry, 

such as user number, receiver type, channel number etc. 
 

Record selection takes place within the top window, editing takes place in the 
bottom window.  In order to add or delete a record within the top window a 
Context-Sensitive Menu is provided; this is accessed by a Right Click on the 
mouse. 
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2.1 Management Client Database Summary 
 

This is a useful feature and provides a quick overview of system records, 
number of users, team etc; it also includes an event history and very basic call 
logging information, i.e. last call made.  
 
To display the Database Summary: 
 
1. From the View Menu click Database Summary. 

 
2. Select from: 
 
� Database Record Summary – This displays the number of records 

within the database broken down into users, teams etc. 
 
� Database Information – This provides user-entered database 

information such as customer name and location; these elements can 
be directly edited within this window. 

 
� Database Event History – This shows the date and time at which key 

events last occurred, such as when last online, off-line time and last 
backup. 

 
� Paging Log Summary – Shows information about the live paging log, 

e.g. number of calls and last call made. 
 
 



9261-7625 Issue 1 Page 45 

2.2 Editing & Updating a Record 
 

To edit a user, team, DLC, CFA record or WAD Services, you must select the 
record within the top window.  The details of the record will be displayed in the 
bottom window.  Editable fields are displayed in bold and are selected using 
the mouse or the tab key.  Fields can be classed into three groups: 

 
� Key fields – These must be filled in for the record to be valid and are 

indicated by the following icon  ( ) and form part of the core database 
stored on the paging system. 
 

� Fields that are not required, but still form part of the core database stored 
on the paging system. 
 

� Non-core fields that are only stored within the local database, such as 
names, location etc. 

 
Any changes made to a record are immediately mirrored in the top window, 
but they are not downloaded to the paging system.  In this state the 
Management Client considers an edit to be ‘active’ and will not allow any 
operations on any other records until the edit has been accepted and updated. 
 
To accept a record press the Return or TAB key, to update a record press the 
Record Update button or the F10 key.  Any edits made prior to an Update can 
be ‘undone’ by selecting the Esc key. 
 
When the paging system is online, performing an update will transfer the 
modifications from the Management Client to the Paging System, ensuring 
that the two databases are synchronised. 
 
When the Management Client is connected to the Paging System, it will notify 
you of any changes made from other input devices, such as the Local Control 
Unit.  If an external change is made to a record currently being edited a 
warning will be displayed and the current edit will be aborted. 

 
 
2.3 Re-numbering a Record 
 

When a new user, team, set or DLC has been created, a record number is 
automatically allocated.  This number can be changed if the default is 
unsuitable.  This is only applicable to newly created records. 
 
Note:  Groups can be given an alphanumeric ID, not just a number; these can 
be changed at any time, not just when newly created. 
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2.4 Special Edit Controls 
 

For many items, special edit controls are provided.  These are only available 
when editing an item and perform context-specific operations.  For example, 
when editing a user number in a newly created record, an up/down control is 
available: 
 

 
 
 
Pressing the up arrow will change the user number to the next unused user 
number in the database.  Pressing the down arrow will change it to the next 
previous unused user number in the database.  The following special edit 
controls are available: 
 
 

Edit Options Field Function 
User Edit User Next/Previous unused user number 

 
 Transfer Next/Previous valid (used) user number 

 
 Receiver No. Next/Previous unassigned receiver 

number 
 

Team Edit 
 

Team Next/Previous unused team number 

Team Member 
 

User Next/Previous compatible user number 

DLC 
 

Next/Previous unused DLC number 

User 
 

Next/Previous compatible user number 

DLC Record 

Team 
 

Next/Previous compatible team number 

CFA Message Message No. Next/Previous unused CFA message 
number 
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3. OPERATOR ADMINISTRATION 
 

The client is the program running on the remote machine, this can be the 
Paging Client, Management Client or Engineering Client.  The operator is the 
person who logs into the client (analogous to WindowsTM users). 
 
Access rights are applied to an operator in order to control what they can or 
cannot do, these are determined solely for the operator and not the client. Any 
operator can log in to any client, however their ability to perform operations is 
dependent upon their assigned access rights. For example, an operator with 
only user paging rights can log in to a paging client, but will only see a list of 
users. 
 
As Access 3000 Server supports concurrent client operation it is possible to 
create more operators than there are available client licences.  Should more 
operators connect to the system than there are actual licences then Access 
3000 Server will display the following notice: 
 

 
 
 
To resolve this problem additional client licences will be required.  Multitone 
can supply this by creating an Amended Authorisation Code. 
 

 
3.1 Selecting the Operator Database 
 

Before you can create, edit or delete an Operator you will need to select the 
Operator Database window.  The top Window is used for selecting, creating or 
changing Operator Record.  The bottom Window is used to add and change 
individual Operator record details: 

 
1. From the View Menu click Operators 
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3.2 Creating an Operator (Client) 
 

1. Select the Operator database 
 
2. From the top window, right click and select Add Operator. 

 
3. Go to the bottom Window, Operator Details, select each item in the right 

hand column:  
 

a. Operator – Click the bold text and enter the required Operator ID. This 
is used as the primary means for identifying the operator, e.g. John 
Brown. 

 
b. Access Rights – Click the bold text, from the drop list box click to 

select the required access rights.  Access 3000 Server supports eight 
pre-defined levels of access rights, these are: 

 
� None View only (cannot even log on to paging 

client). 
 

� Basic Paging User, set, group paging, group edit and call 
scheduling if enabled. 
 

� Full Paging User, team, sets, group paging, group edit 
and call scheduling if enabled. 
 

� Operator All paging features including edit users, edit 
teams, sets and groups plus call scheduling if 
enabled. 
 

� Supervisor All paging features and all Management client 
features except Edit Operators and A3K 
Engineering Access - Server and database 
back-up and restore on the Engineering 
Client. 
 

� Engineer All Paging, Engineering and Management 
client features except Password Edit. 
 

� System 
Administrator 

All Paging, Engineering and Management 
client features. 
 

� Custom Click on the flags (tick boxes) to select any of 
the required options. 

 
Alternatively, you can click any flag (tick boxes) as appropriate without 
having to select Access Rights list box to define an operating client. 
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c. Full Name – If required enter the full name of the operator client 
 
d. Password – Enter a unique password for each client, the entered 

password will be displayed in asterisks: ******  
 

4. At Operator Information – Details and Notes - Enter information as 
appropriate and press the Return Key. 

 
5. When completed click the Update record button. 
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3.3 Editing an Operator 
 

1. Select the Operator database 
 
2. From the top window click on the Operator you wish to edit. 

 
3. Go to the bottom Window, Operator Details, select the items you wish to 

edit:  
 

 
 
 

a. Operator – Click on the Operator ID, e.g. John Brown and amend as 
necessary. 

 
b. Access Rights – Click on the Current Rights, e.g. System Admin and 

select alternative access rights from list box.  Alternatively, click 
appropriate flags (tick boxes) to amend current rights. 

 
c. Full Name – If required enter the full name of the operator. This is used 

for descriptive purposes only. 
 
d. Password – You may remove the current password by deleting it or you 

may overtype the current password so entering a new password for the 
operator client.  The entered password will be displayed with asterisks: 
****** 

 
4. At Operator Information – Details and Notes - Enter and change 

information as appropriate and press the Return Key. 
 

5. When completed click the Update record button. 
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3.4 Deleting an Operator 
 

1. Select the Operator database 
 
2. From the top window click on the Operator you wish to edit. 

 
3. Right click and select Delete Operator 

 
4. You will now be asked to confirm the action, select Yes or No. 

 
Note:  Deleting an operator will also delete all of the operator’s personal 
groups (see later).  
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4. USER RECORDS 
 
 A user is an individual who holds a pager.  
 
 
4.1 Selecting the User Database 
 

Before you can create, edit or delete a user record you will need to select the 
User Database Window.  Having selected User Database, the top Window is 
used for selecting, adding or changing a User Record.  The bottom Window is 
used to add and change individual record details: 

 
1. From the View Menu click Users. 
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4.2 Creating a New User Record 
 
1. Select the User Database. 

 
2. From the top window, right click and select Add User - A new user record 

will be created using the next available user number. 
 

3. Go to the bottom Window, User Details – Select each item in the right hand 
column: 

 
a. User Number - Use the Up and Down keys to select an alternative user 

number. 
 
b. Title, First Name, Last Name and Job are optional record items.  Select 

each item and type in relevant information. 
 

c. Status - Select In or Out from the drop down list box. 
 

d. Transfer - This is optional, use the Up and Down keys to select the 
transfer number. 

 
e. Receiver Number – Use the Up and Down keys to select a receiver 

number. 
 

f. Receiver Type - Select the receiver type from the drop down list box. 
 

g. Channel – If there is more than one channel available, you can select 
these using the tick boxes.  If you have a speech pager and you select 
multiple channels you will not be able to send speech messages. 

 
h. Services – This is optional, select the service type from the tick boxes: 

Phone Message, Phone Speech or Phone Reply. 
 

4. Select User Information – All fields are optional, type in relevant 
information in the right hand column.  

 
5. Press the Return Key to accept the changes. 

 
6. Click Update record button. 
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4.3 Editing a User Record 
 

1. Select the User Database. 
 
2. Select the User Number you wish to edit. 

 
3. Go to the bottom Window: 

 
a. Select User Details – You may edit all highlighted items in bold, plus 

Transfers and Services. 
 
b. Select WAD Settings (If applicable) – You may change the Dial-out 

Service and Wide Area ID.  See also WAD Services (Section 12.3). 
 
c. Select User Info – You may change and amend all items. 

 
d. Team  - This cannot be edited. 

 
4. Click Update record button to enter the changes. 
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4.4 Duplicating a User Record 
 
You can also duplicate a user.  This allows you to automatically generate a 
new user record using existing settings: 
 
� The new user number will be the next available user number after the 

selected user.  
 
� Record status, receiver type, channels and speech options will be copied 

from the selected user. 
 

� The receiver number will be the next available number for the specified 
receiver type. 

 
1. Select the User Database. 

 
2. From the top window, right click and select Duplicate User. 

 
3. Go to the bottom Window, select User Details – Select each item in the 

right hand column: 
 

a. User Number - Use the Up and Down keys to select an alternative user 
number. 

 
b. Title, First Name, Last Name and Job are optional record items.  Select 

each item and type in relevant information. 
 

c. Status - Select In or Out from the drop down list box. 
 

d. Transfer - This is optional, use the Up and Down keys to select the 
transfer number. 

 
e. Receiver Number – Use the Up and Down keys to select a receiver 

number. 
 

f. Receiver Type - Select the receiver type from the drop down list box. 
 

g. Channel – If there is more than one channel available, you can select 
these using the tick boxes.  If you have a speech pager and you select 
multiple channels you will not be able to send speech messages. 

 
h. Services – This is optional, select the service type from the tick boxes: 

Phone Message, Phone Speech or Phone Reply. 
 
4. Select User Information – All fields are optional, type in relevant 

information.  
 
5. Press the Return Key to accept the changes. 

 
6. Click the Update record button. 
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4.5 Deleting a User 
 

1. Select the User Database Window. 
 
2. Go to the top Window select the User you wish to delete. 
 
3. Right click and select Delete User. 

 
4. You will now be asked to confirm the action, select Yes or No. 

 
Note:  Only a user with no transfer, team, set or DLC use can be deleted. 
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4.6 Adding a User to a Team 
 
1. Select the User Database. 
 
2. Go to the top Window and select the User you wish to enter into a team. 

 
3. Right click and select Add to Team - A list of all the destination teams will 

be displayed: 
 

 
 
 
 
 
 
 
 
 
 
This list will only display those teams that are compatible with the user - 
matching channels, message type etc.  If you select ‘Show All Teams’ all 
the available teams will be displayed.  If you attempt to add a user to an 
incompatible team an error will be displayed explaining the incompatibility. 
 

4. Select the destination team – The Management Client will automatically 
open up the Teams Database. 

 
5. Click the Update record button. 
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4.7 Adding a User to a Set 
 
1. Select the User Database. 
 
2. Go to the top Window and select the User you wish to enter into a Set. 

 
3. Right click and select Add to Set - A list of all the destination Sets will be 

displayed: 
 

 
 
 
This list will display all Sets.  Note that the set message facilities are 
dynamic and will be changed to accommodate the features of the pager 
with the least facilities.   
 

4. Select the destination set – The Management Client will automatically 
open up the Set Database. 

 
5. Click the Update record button. 
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4.8 Adding a User to a Group 
 

1. Select the User Database. 
 
2. Go to the top Window and click the User you wish to enter into a Group. 

 
3. Right Click and select Add to Group - A list of all the destination Groups 

will be displayed: 
 

 
 
This list will display all Groups.  Note that the group message facilities are 
dynamic and will be changed to accommodate the features of the pager 
with the least facilities. 
 

4. Select the destination group – The Management Client will automatically 
open up the Group Database. 

 
5. Click the Update record button. 
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4.9 Setting Up a Wide Area User 
 
Wide-area user records, while stored in a separate database on the paging 
system, are integrated into the main user editing process.  When one or more 
wide area channels are selected for a user, the bottom window of the User 
Database will include a ‘Wide Area Settings’ section, containing a sub-section 
for each of the user’s wide-area channels. 
 
 

 
 
 
1. To change the dial-out service for a user on a channel, select the required 

service from the drop down ‘Dial-out Service’ list box. 
 
2. When a valid service is selected, the ‘Wide Area ID’ field becomes visible – 

Type in the ID.  The Wide Area ID is usually the telephone number of the 
paging service being called. 
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5. TEAM RECORDS 
 

A Team is a collection of users and/or groups of pagers (Format Groups) that 
may be paged by a single call.  Team members whose pagers are in an 
Absence Rack will not be paged. 
 
The Teams Database Window shows both the teams and team members.  
The top Window allows you to select, create, edit and delete a team record.  
This Window also contains details of team members and format groups.  The 
bottom Window shows all the team configuration details 
 
 

5.1 Selecting the Teams Database 
 
1. From the View Menu click Teams. 

 
To view Team Members and/or Format Groups: 
 
1. Select the Team you require. 
 
2. Double Click on the team icon to view the hierarchy of team members and 

format groups. 
 

Note:  A Format Group is a group of 10 or 100 pagers of the same receiver 
type having a common 1 or 2-digit receiver number, e.g. Base receiver 
address is 750 and a group size is 10 will allow pagers 750 to 759 to be called 
as a single team. 
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5.2 Creating a New Team 
 

1. Select the Team Database. 
 
2. From the top Window, right click and select Add Team – A new team will 

be created using the lowest possible team number. 
 

3. Go to the bottom Window and select Team Details – Select items in the 
right hand column: 

 
a. Team – Use the Up and Down keys to select an alternative number. 
 
b. Name and Function – These are optional record items.  Select each 

item and type-in the required information. 
 

c. Channel – If there is more than one channel available, you can select 
these using the tick boxes.  If you have a speech pager and you select 
multiple channels you will not be able to send speech messages. 

 
d. Message Type – Select the message type from the list box provided. 

 
e. Message Length – Type-in the message length. 

 
f. Speech – Click on the speech tick box. 

 
4. Select Team Information – All fields are optional, type in relevant 

information in the right hand column.  
 
5. Press the Return Key to accept the changes. 
 
6. Press the Update Record button. 
 
Note: 
 
1. Once a team has been created it may be edited from the bottom Window.  

Only a newly created team with no members can be edited in this way.  
Once users have been added to a team its configuration will be fixed. 

 
2. A newly created team has no members and cannot, therefore, be paged.  

Empty teams are highlighted with a different icon and colour in the top 
Window ( ).  The Management Client will not allow you to close the 
application, or perform a backup or restore until a member has been added 
to an empty Team, if not the Team will be automatically deleted. 
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5.3 Adding a User to a Team 
 

1. Select the Team Database. 
 
2. Select the required team from the top window. 

 
3. Right click and select Add to Team Member - The Management Client will 

offer you the next available user number meeting the team characteristics. 
 

4. If you wish to change a team member: 
 

a. Go to the bottom window and select User - Use the Up and Down keys 
to select an alternative number 

 
b. Press the Return Key to accept the change. 

 
5. Click the Update record button - If the user number is incompatible a 

warning message describing the incompatibility will be generated, either 
amend the record or cancel or abort the operation. 
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5.4 Adding a Format Group to a Team 
 

1. Select the Team Database. 
 
2. Select the required team from the top Window. 
 
3. Right click and select Add Format Group - A format group will now be 

added to the team. 
 
4. Go to the bottom window and select: 

 
a. Receiver type - If you wish to use an alternative receiver, click on 

Receiver Type and select from the list provided. 
 
b. Base Address – Type in the receiver base address to which you want 

the format group to start. 
 

c. Group size – Select from the list provided – 10 or 100 users. 
 

5. Press the Return Key to accept changes. 
 
6. Click the Update record button. 

 
Note:  Initially, the new Format Group will be based on a previously selected 
member (if a format group were selected) by incrementing the base address.  
The format group details may then be changed, if necessary, by editing the 
receiver type, base address, and group size 
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5.5 Editing a Team Member or a Format Group 
 

1. Select the Team Database. 
 
2. Select the required team from the top window. 

 
3. Click the Team Record to display Team Members and/or Format Groups. 

 
4. Click the Team Member or Format Group you wish to edit. 

 
a. Editing a Team Member – Use the Up and Key to select an alternative 

team member.  No other records can be changed. 
 
b. Editing a Format Group – You can only change the following items: 

 
� Select a new receiver type from the list box 

 
� Select the receiver base address, 

 
� Select group size, 10 or 100 from the list box. 

 
5. Click the Update record button. 
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5.6 Deleting a Team Record 
 

1. Select the Team Database. 
 
2. Select the team record you wish to delete. 
 
3. Right click and select Delete Team. 

 
4. You will now be asked to confirm the action, select Yes or No. 

 
Note: Only a Team with no DLC use can be deleted. 
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5.7 Deleting a Team Member 
 

1. Select the Team Database. 
 
2. Select the team record. 

 
3. Double click on the team record and select the team member you wish to 

delete. 
 

4. Right click and select Delete Team Member. 
 

5. You will now be asked to confirm the action, select Yes or No. 
 

Note:  Deleting the last member of a team, i.e. where a team only has a single 
member, leaves an empty team as if it had just been created. 
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6. SET RECORDS 
 

A Set is a collection of Users who may be paged together.  Calls to Set 
members who have Status Out or Rack will be transferred to a transferee 
number if possible. 
 
The Sets Database Window shows both the Sets and Set members.  The top 
Window allows you to select, create, edit and delete a Set record.  This 
Window also contains details of all Set members.  The bottom Window shows 
all the Set configuration details 
 
 

6.1 Selecting the Set Database 
 
1. From the View Menu click Sets. 

 
To view Set Members: 
 
1. Select the Set you require. 

2. Double Click on the Set icon  to view the hierarchy of Set members.  
(Note, a set member may be a User or another ‘Set’). 
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6.2 Creating a New Set 
 

1. Select the Set Database. 
 

2. From the top Window, right click and select Add Set – A new Set will be 
created using the lowest possible Set number. 

 
3. Go to the bottom Window, Set Details – Select the following items: 

 
a. Set – If you wish to change the set number, click-on the right hand 

column, use the Up and Down keys to select an alternative number. 
 
b. Name – If you wish to give the Set a name, click on the right hand 

column and type-in the name.  
 

c. Function – If you wish to give the Set a function, e.g. Cardiac Support, 
click on the right hand column and type-in the required function.  

 
d. Status – If you wish to change the status of the Set, click-on the right 

hand column and select In or Out from the drop down list box. 
 

e. Transfer - This is optional, click-on the right hand column and use the 
Up and Down keys to select the user number to which you wish transfer 
the Set. 

 
f. Select Set Information – Click-on the right hand column and type-in 

relevant details.  Please note all these fields are optional items only. 
 

4. Press the Return Key to accept these changes. 
 

5. Click the Update record button. 

 
Note: 
 
1. A newly created Set has no members and no defined message capability.  

Only its status In/Out and Information Notes may be edited in the bottom 
window.  The Set message facilities will be adjusted to match this of the 
Set member with least message facilities.  

 
2. A newly created Set has no members and cannot, therefore, be paged.  

Empty Sets are highlighted with a different icon and colour in the top 
Window ( ).  The Management Client will not allow you to close the 
application, or perform a backup or restore until a member has been added 
to an empty Set, if not the Set will be automatically deleted. 
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6.3 Adding a User to a Set 
 

1. Select the Set Database. 
 
2. From the top window click on the required Set. 

 
3. Right click and select Add Set Member - The Management Client will offer 

you the next available user number. 
 

4. If you wish to change a Set member: 
 

a. Go to the bottom window and select User – Click-on the right hand 
column and Use the Up and Down keys to select an alternative 
number. 

 
b. Press the Return Key to accept the change. 

 
5. Click the Update Record button. - If the user number is incompatible a 

warning message describing the incompatibility will be generated, either 
amend the record or cancel or abort the operation. 
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6.4 Editing a Set Record 
 
 When editing a Set you may only amend the Set Name, Function, Status, 

Transfers and Set Information: 
 

1. Select the Set Database. 
 
2. Select the required Set from the top window. 

 
3. Go to the bottom Window, Set Details – Select the following items: 

 
a. Name – If you wish to give the Set a name, click on the right hand 

column and type-in the name.  
 
b. Function – If you wish to give the Set a function, e.g. Cardiac Support, 

click on the right hand column and type-in the required function.  
 

c. Status – If you wish to change the status of the Set, click-on the right 
hand column and select In or Out from the drop down list box. 

 
d. Transfer - This is optional, click-on the right hand column and use the 

Up and Down keys to select the user number to which you wish transfer 
the Set. 

 
e. Select Set Information – Click-on the right hand column and type-in 

relevant details.  Please note all these fields are optional items only. 
 

4. Press the Return Key to accept these changes. 
 

5. Click the Update record button. 
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6.5 Deleting a Set Record 
 

1. Select the Set Database. 
 
2. Select the Set record you wish to delete. 

 
3. Right click and select Delete Set. 

 
4. You will now be asked to confirm the action, select Yes or No. 
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6.6 Deleting a Set Member 
 

1. Select the Set Database. 
 
2. Select the Set Record. 

 
3. Double click the Set Record and click the Set member you wish to delete. 

 
4. Right click and select Delete Set Member. 

 
5. You will now be asked to confirm the action, select Yes or No. 

 
Note:  Only a Set with no transfer, Set or DLC use can be deleted. 
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7. GROUPS 
 

Unlike team paging, which is reserved for critical, life-saving applications, it is 
possible to create groups on both the Management Client and Paging Client 
which can be used as a less formal means of paging non-critical teams.   

 

 
 
 
7.1 Selecting the Group Database 

  
1. From the View Menu click Groups 

 
To view Group Members: 
 
2.  Select the Group you require. 

3. Double Click on the Group Icon  to view the list of Group members.   
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7.2 Creating a New Group 
 
You may create two types of group - Personal Groups or System Groups.  A 
Personal Group is ‘personal’ and can only be created, edited and viewed by 
the operator who created the group.  A System Group is more formal as it can 
be seen by all operators but can only be edited those with system group edit 
permissions. 

 
1. Select the Group Database. 
 
2. From the top Window, right click and select Add Personal Group or Add 

System Group.  A new Group will be created: 
 

 
 
 

3. Go to the bottom Window, Personal Group Details, select the following: 
 

a. Group – This is used to identify the Group, enter the group name or 
number, for example, Secretaries, My Colleagues, Doctors. This can be 
any combination of characters and digits, and can be a descriptive as 
desired. 

 
b. Name – If you wish to give the Group a more descriptive name, click on 

the right hand column and type-in the name.  
 

c. Function – If you wish to give the Group a function, e.g. Weekly Team 
meeting, click on the right hand column and enter the required function.  

 
d. Department – Enter department details as required.  

 
e. Select Group Information – Click-on the right hand column and type-in 

relevant details.  Please note all these fields are optional items only. 
 

4.  Press the Return Key to accept these changes. 
 

5.  Click Update. 
 
Note:  A newly created Group has no members and therefore cannot be 
paged.  The Group message facilities will be adjusted to match those of the 
Group member with least message facilities, e.g. a numeric pager.  Empty 
Groups are highlighted with a different icon and colour in the top Window ( ).  
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7.3 Adding a User Member to a Group 
 

1. Select the Group Database. 
 

2. From the top window click on the required Group, e.g. Person Group 1. 
 

3. Right click and select Add Group Member - The Management Client will 
offer you the next available user number: 

 

 
 
 

4. If you wish to change a Group member go to the bottom window 
 
5. Select Group Member Details – Click-on the right hand column and Use 

the Up and Down keys to select an alternative User number. 
 

6. Press the Return Key to accept the change. 
 

7. Click Update - If the user number is incompatible a warning message 
describing the incompatibility will be generated, either amend the record or 
cancel or abort the operation. 
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7.4 Adding a Group to a Group 
 

1. Select the Group Database. 
 

2. From the top window click on the required Group, e.g. Person Group 1. 
 
3. Right click and select Add Group - The Management Client will offer you 

the next available Personal or System Group: 
 

 
 
4. If you wish to change a Group go to the bottom window 

 
5. Select Group Member Details – Click-on the right hand column and Use 

the Up and Down keys to select an alternative Group number. 
 

6. Press the Return Key to accept the change. 
 

7. Click Update - If the user number is incompatible a warning message 
describing the incompatibility will be generated, either amend the record or 
cancel or abort the operation. 
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7.5 Editing a Group 
 
 When editing a Group you may only amend the Set Name, Function, Status, 

Transfers and Set Information: 
 

1. Select the Group Database. 
 

2. Select the required Group from the top window. 
 

3. Go to the bottom Window, Group Member Details – Select the following 
items: 

 
a. Group – This is used to identify the Group, enter an alternative group 

name or number. 
 
b. Name – If you wish to give the Group a new name, click on the right 

hand column and type-in the name.  
 

c. Function – If you wish to give the Group a function, e.g. Weekly Team 
meeting, click on the right hand column and enter the required function.  

 
d. Department – Enter department details as required.  

 
e. Select Group Information – Click-on the right hand column and type-in 

relevant details.  Please note all these fields are optional items only. 
 

4.  Press the Return Key to accept these changes. 
 
5.  Clicks Update.  
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7.6  Deleting a Group 
 

1. Select the Group Database. 
 

2. Select the Group record you wish to delete. 
 

3. Right click and select Delete Group. 
 

4. You will now be asked to confirm the action, select Yes or No. 
 

Note: 
 
Deleting a group will automatically remove that group from any other groups of 
which it is a member. 
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7.7 Deleting a Group Member 
 

1. Select the Group Database. 
 
2. Select the Group Record. 

 
3. Double click the Group Record and click the Group member you wish to 

delete. 
 

4. Right click and select Delete Group Member. 
 

5. You will now be asked to confirm the action, select Yes or No. 
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8. SCHEDULER 
 

Access 3000 Server also incorporates a call scheduling facility, which is fully 
integrated into the paging client.  The management client does not provide 
editing facilities but does allow all scheduled calls to be viewed. 
 
The call scheduling facility enables an operator to enter and send a message 
at some future point-in-time.  Simply select the user, team, set or group then 
determine the time and message priority and Access 3000 Server will process 
the call at the pre-determined time.  By pre-booking paging calls, Call 
Scheduler acts as a mobile diary reminding the recipient of appointments or 
actions that need to be undertaken on a one-off or regular basis.  Calls can be 
scheduled at anytime, either on a daily (1 to 7 days), weekly, monthly or a 
yearly basis.    
 
Call Scheduler though integrated into the Access 3000 Server is in fact a 
separate product and can only be initiated via its own unique authorisation 
code and can be supplied in addition to the standard authorisation code. 
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8.1 Viewing Scheduled Calls 
 

1. From the View Menu click Scheduled Calls. 
 
2. The Scheduled Calls window will now be displayed: 

 

 
 
 

The scheduled call list appears in the paging and management clients, and 
lists some or all of the scheduled calls on the system.  The list can be sorted 
according to any column.  When sorted according to call time (the default), the 
list shows calls in the order in which they would occur on any given day.  The 
icon and colour used in each row in the table is governed by the current state 
of the call: 

 
Colour Description 
Green Call scheduled to occur today 
Normal/White Call will not occur today 
Grey Scheduled call is disabled 
Light blue The “next” scheduled to occur (although this may not be 

today, or may be disabled) – this colour is merged with the 
above colours. 

Red The last time the call went out, there was an error – the call 
was not sent 

 
 

Icon Description 
 Normal scheduled call 
 The last time the call went out, there was an error – the call 

was not sent 
 

The next call to be sent is indicated with a small yellow arrow (e.g. ), calls 
not due to be sent today will have a lighter icon (e.g. ), and disabled calls 
are marked with a red cross (e.g. ). 
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9.  DLC RECORDS 
 

 The correct title for the DLC records database is Direct Line Connection 
Service.  It may be referred to as the DLC Database.  A DLC record refers to 
an electrical contact, e.g. a Doorbell, normally this is the DLC input. 
 

 
9.1 Selecting the DLC Records Database 

 
Before you can create, edit or delete a DLC record you will need to select the 
DLC Database: 

 
1. From the View Menu click DLC. 

 
Having selected the DLC Database, the top Window is used for selecting, 
adding or changing a DLC Record.  The bottom Window is used to add and 
change individual DLC record details. 
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9.2 Creating a New DLC Record 
 

1. Select the DLC database. 
 
2. Go to the top window, right click and select Add DLC - This will create a 

new DLC record using the next available DLC record number.  
 

3. Go to the bottom window. 
 

4. Select DLC Details – Select items in the right hand column: 
 

a. If required you can select an alternative DLC Number - Use the Up the 
Down keys to select an alternative number. 

 
b. If required, you may enter details into the Name, Location and Notes 

fields. 
 

5. Select DLC Settings – Select items in the right hand column: 
 

a. Select User or Team - Use the Up and Down keys to select the 
next/previous compatible user or team - User and team settings are 
mutually exclusive, entering a user number will automatically remove 
any existing team number and vice-versa. 

 
b. Output DLC – If required, type in the DLC output number.   An output is 

another electrical contact, which is activated as a result of a DLC input. 
 

c. Output Activation – Select Activate and optional Timed. 
 

d. Message text – You can enter a new message.  If a user or team has 
been allocated RFA receivers, an RFA Number field will be displayed, 
select an RFA message number. 

 
e. Priority – Select the priority from the drop down list. 

 
f. Speech MCU – If required, type-in the MCU number (See note below). 

 
6. Press the Return Key to accept the amendments. 
 
7. Click the Update record button. 

 
Note:  Click on View and select Configuration to ascertain the total number of 
DLC speech sources on the system. Speech MCUs are numbered from zero 
onwards.  If speech is required, the MCU operator will be able to speak to a 
pager after the DLC contact has been activated.  
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9.3 Editing a DLC Record 
 

1. Select the DLC database. 
 
2. Select the DLC record you wish to edit.  

 
3. Go to the bottom window. 

 
4. Select DLC Details - You can only edit the Name, Location and Notes 

fields. 
 

5. Select DLC Setting – You can edit all the following fields: 
 
a. Select User or Team - Use the Up and Down keys to select the 

next/previous compatible user or team - User and team settings are 
mutually exclusive, entering a user number will automatically remove 
any existing team number and vice-versa. 

 
b. Output DLC – If required, type in a new DLC output number. This is an 

unusual item and used very rarely. 
 

c. Output Activation – Select Activate and optionally timed. 
 

d. Message text – You can enter a new message.  If a user or team has 
been allocated RFA receivers, an RFA Number field will be displayed, 
select an RFA message number. 

 
e. Priority – You can select a new priority from the drop down list. 

 
f. Speech MCU – If required, type-in a new MCU number (See note on 

page 54). 
 

6. Click the Update record button to enter changes. 
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9.4 Deleting a DLC Record 
 

To delete a DLC record, select the DLC within the DLC primary view then: 
 
1. Select the DLC database. 
 
2. Select the DLC that you wish to delete. 

 
3. You will now be asked to confirm the action, select Yes or No. 
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10. CFA RECORDS 
 
 
10.1 Selecting the CFA Record Database 
 

To display the contents of the Central Fast Alpha (CFA) message database 
you will need to select the CFA Database: 

 
1. From the View Menu click CFA Messages. 

 
Having selected the CFA Message database, the top Window is used for 
selecting, adding or synchronising a CFA Record.  The bottom Window is 
used to add and change individual CFA record details. 

 
Note:  Messages that can be used for Receiver Fast Alpha (RFA Messages) 
are shown in this Window with a special icon ( ). 
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10.2 Creating & Editing a CFA Message 
 

1. Select the CFA Message database. 
 
2. From the top window, right click and select Add Message - A new CFA 

message using the next unused message number will be created.  To edit 
a CFA message, click on the message you wish to amend. 

 
3. Go to the bottom window to ‘add’ or ‘change’ the message number and 

message text. 
 

4. Press the Return Key to accept the changes. 
 

5. Click the Update record button. 
 

Note:  Depending on the current paging language, some characters will not be 
available.  These will simply be ignored if entered during message editing. 
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10.3 Deleting a CFA Message 
 

1. Select the CFA database. 
 
2. Select the CFA message that you wish to delete. 

 
3. Right click and select Delete CFA message. 

 
4. You will now be asked to confirm the action, select Yes or No. 
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11. WIDE AREA DIALOUT OR WAD DATABASE 
 

 The Wide Area Dial-out facility supports the TAP Protocol and will support 
wide area paging and TAP text messaging. 

 
 
11.1 Selecting the WAD Database 

 
To display the contents of the Wide Area Services Database (WAD) in the 
primary view: 
 
1. From the View Menu click WAD Services. 

 
The top window represents the WAD Channels and Services, while the bottom 
window displays WAD configuration in terms of Service Details, Link Settings 
and Serial Port Configuration. 

 
Note:  Unlike all the other sections of the database, there are always twenty 
dial-out services, and one dial-in/link service per WAD channel.  Performing a 
database backup will automatically save the full set of WAD services. 
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11.2 Adding a New WAD Channel/Dial-in/Link Service 
 

Each WAD channel supports a single Dial-in/Link service; thus creating a new 
channel effectively creates one of these services.  To set-up an unused WAD 
channel: 

 
1. Select WAD Services. 
 
2. From the top window, right click and select ‘Add Channel/Link/Dial-in’.  The 

channel must be present in the paging system parameters.  You can check 
this by looking at the system configuration (See Section 13). 

 
3. Go to the bottom window to edit the Dial-in/Link service settings: 

 
a. WAD Service Details - Select the channel from the drop down list.  If 

required, enter details of the Channel Name, Location or Service and 
any notes you wish to add. 

 
b. Link Settings - Select the settings you require from the drop down lists.  

Depending on the settings selected, various configuration options will 
become available.  For example Dial Type is only available for Modem 
connections. 

 
c. Serial Port - Select each setting from the drop down lists. 

 
4. Press the Return Key to accept the changes. 
 
5. Click the Update button – If the service is not accepted, e.g. if the 

hardware associated with the WAD channel is not installed the new 
channel will not be set-up.  
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11.3 Adding a New WAD Dial-out Service 
 

Each WAD channel supports exactly twenty Dial-out services.  These can only 
be set up on an existing WAD channel.  To create a new Dial-out service: 
 
1. Select WAD Services. 
 
2. From the top window, click on one of the unused service numbers. 

 
3. Go to the bottom window to edit service settings for the selected service 

number. 
 

a. WAD Service Details – If required enter details of the Service Name, 
Location and any notes you wish to add. 

 
b. Link Settings - Select the protocol from the drop down list.  If required 

type-in an ID Prefix (local identifier) and a Password (This is usually 
supplied by the service provider e.g. Vodapage).  Normally ID type = 
NONE will be selected. 

 
4. Press the Return Key to accept the changes. 
 
5. Press the Update record button. 

 
Note:  If the 20-dialout services are not displayed: 
 
� Select the WAD Services database. 
 
� From the top window, right click and select Add-Dial-out Service. 

 
� Right click and select ‘Yes’ to Synchronise (If the Management Client is 

online). 
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12. DATABASE MANAGEMENT 
 
 
12.1 Database Backup 
 

The Access 3000 database back-up parameters can be set-up and edited 
using the Management Client running on the Server only. Database Backup 
sets the frequency at which the Access 3000 database is backed up to the 
Server: 

  

 
 

  
1. From the View Menu click Server Options then go to the Database 

Backup item. 
 

2. From Period click right hand column and select the time period at which 
the Access 3000 Database is backed-up.  This may be Daily, Weekly or 
Monthly: 

 
• If you have selected Daily, click on the Time field 00:00:00 and set the 

time at which the database is backed-up, the default is 23:59:00. 
 
• If you have selected Weekly set the Time, then from Day of Week click 

on the Day field e.g. Sunday and select the required day from the list 
box. 

 
• If you have selected Monthly, set the Time, then from Day-of-Month 

click on the Day filed and use the Up and Down arrow key to select the 
day-of-month, 1 to 31 days. 

 
3. From Days to Keep click on the number of days (e.g. 365) to determine 

how long the backups are kept - This can be as many days as you 
require.  Type-in the days required, or use the up and down arrow keys to 
select. 
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4. Please note that the Directory can only be set-up from the Management 
Client running on the Server computer.  Using Windows Explorer create 
an Access 3000 Database archive directory e.g. C:\A3kArchive. 

 
5. From Directory click on the right-hand column, then either enter a 

backup location manually, or click the button on the left-hand-side to 
bring up the Browse for Folder dialog box - select the appropriate folder, 
e.g. A3kArchive, click OK to confirm. 

 

 
 

6. Click the Update button to confirm all changes, saving them to the server. 
 
Note:  A database backup comprises the entire database including all 
users, teams, operators etc. plus the full call and event logs 
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12.2 Event Log Purge 
 

The Event Log stores all the transactions between the clients, server and 
Access 3000 system.  This can amount to many thousands of events over 
time, thus old events must be regularly purged. Event Log Purge sets the 
frequency at which events are removed from the log: 

 

 
 
 
5. From the View Menu click Server Options then go to the Event Log 

Purge item. 
 
6. From Period click the right hand column and select the time period at 

which the Access 3000 Database is backed-up.  This may be Daily, 
Weekly or Monthly: 

 
• If you have selected Daily, click on the Time field 00:00:00 and set the 

time at which the database is backed-up, the default is 23:59:00. 
 

• If you have selected Weekly set the Time, then from Day of Week click 
on the Day field e.g. Sunday and select the required day from the list 
provided. 

 
• If you have selected Monthly, set the Time, then from Day-of-Month 

click on the Day filed and use the Up and Down arrow key to select the 
day-of-month, 1 to 31 days. 

 
7. From Days to Keep click on the number of days (e.g. 365) to determine 

how long the records are kept in the log – This can be as many days as 
you require.  Type-in the days required, or use the up and down arrow 
keys to select.  

 
8. Click the Update button to confirm all changes, saving them to the server. 
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12.3 Call Log Purge 
 
The Call Log stores all the calls made by the Access 3000 system. Like the 
event log this can amount to many thousands, if not millions of calls over time, 
and must be regularly purged. Call Log Purge sets the frequency at which 
calls are removed from the log:   
 

 
 

 
1. From the View Menu click Server Options then go to the Call Log Purge 

item. 
 
2. From Period click the right hand column and select the time period at 

which the Access 3000 Database is backed-up.  This may be Daily, 
Weekly or Monthly: 

 
• If you have selected Daily, click on the Time field 00:00:00 and set the 

time at which the database is backed-up, the default is 23:59:00. 
 

• If you have selected Weekly set the Time.  From Day of Week click on 
the day field e.g. Sunday and select the required day from the list 
provided. 
 

• If you have selected Monthly, set the Time, then from Day-of-Month 
click on the Day filed and use the Up and Down arrow key to select the 
day-of-month, 1 to 31 days. 

 
3. From Days to Keep click on the number of days (e.g. 365) to determine 

how long the records are kept – This can be as many days as you require.  
Type-in the days required, or use the up and down arrow keys to select.  

 
4. Click the Update button to confirm all changes, saving them to the server. 
 

 
 

 



9261-7625 Issue 1 Page 97 

12.4 Access 3000 Serial Link 
 

Please note that configuration of the Access 3000 serial link can only be 
undertaken from the Management Client running on the Server computer. 

 

 
 

 
1. From the View Menu click Server Options then go to the A3K Serial Link 

item. 
 

2. From the Serial Link options click the relevant set-up parameters in the 
right hand column, changing settings as required. 

 
3. Click the Update button to confirm all changes, saving them to the server. 

Any change to the link settings will force the Access 3000 to re-connect 
and perform a full re-synchronisation with the server. This should be 
transparent to any operators using the system. 
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13. EDITING PAGING SYSTEM CONFIGURATION DATABASE 
 

When Management Client connects to the A3k Server, it downloads 
configuration data (the ‘SSF’) from the paging system.  This data contains 
information about devices, channels, receivers and other system parameters 
and affects the way data is displayed and edited within the database. 
 
Note that core paging system data can be viewed but not edited as it is taken 
from the Access 3000 itself. 
 
To display the Paging System Configuration database: 
 
1. From the Main View click Configuration. 

 
The Paging System Configuration database shows five groups of data 
covering: 

 
1. Paging System Parameters – Select this to display the core paging system 

configuration parameters including serial number, language, number of 
digits etc. 

 
2. Receiver Details – Select this to display details of each receiver type 

supported by the paging system.  This includes code format, supported 
channels and message length etc. 

 
3. Channel Details – Select this to display details of each channel supported 

by the system showing the channel address, editable name and notes 
fields, and an indication of wide-area channels ( ). 

 
4. Device Details – Select this to display details of each device on the system 

providing editable name and notes fields, and an indication of whether the 
device is present ( ). 
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13.1 Editing Receiver, Channel and Device Details 
 

For Receiver Details, Channel Details and Device Details it is possible to re-
name or edit description fields.  This will make it easier for the System 
Supervisor to select the right receiver and paging channel when creating a 
new user or team etc. 
 
1. Select Configuration. 
 
2. Select the database you wish to re-name or edit, e.g. Receiver Details, 

Channel Details or Device Details. 
 

3. Select the field you wish to change this is highlighted in bold.  You may 
also append a note in the Notes field if you wish to add additional 
information. 

 
4. Type in the change. 

 
5. Press the Return Key to update the field. 

 
6. Click the Update button to confirm all changes, saving them to the server. 
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14. CALL LOGGING & ANALYSIS 
 

Management Client provides extensive call logging and analysis features.  
The call log database maintains a complete history of all calls made by Access 
3000.  The Management Client is supplied with four pre-configured call log 
views, these are: 
 
� The Live Call Log  - This lists all paging calls made on the system.  Please 

note that this item cannot be printed, as it can be vast (thousands, even 
millions of pages). 

 
� Last Month Call Log - This lists all the calls made in the last month. 

 
� User Call Count - This lists all the users called and the number of times 

they were called. 
 

� Device Call Count - This lists all the source devices from which a paging 
call has been made and shows the number of times a call was made from 
each device. 

 
In addition to these standard views it is possible to create a customised call 
log view - or query.  Creating a customised query enables you to specify the 
way in which you wish to archive paging calls, analyse call statistics or look at 
a particular event in greater detail.   

 
Note:  The complete call log is stored on the server and can be accessed from 
a Management Client, running on any suitable computer.  Due to the potential 
large size of this data, a copy is also stored on the client computer so that only 
the latest calls need to be downloaded from the server.  
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14.1 Accessing the Live Call Log 
 

1. From the View Menu click Live Call Log.   
 

 
 
 

2. To examine a call in detail, click the Call Record you wish to view.  Go to 
the bottom window Paging Call Details in order to examine the record in 
greater detail. 

 
Note: 
 
• Team calls are shown as a separate call to each team member (user 

and/or format group). 
 

• Calls highlighted in RED indicate a failed paging call. 
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14.2 Accessing Call Log Queries 
 

To select: Last Month Call Log, User Call Count, Device Call Count or any 
other query, from the View Menu click Call Log Query then click on the 
specific Query you require: 

 

 
 

 
Note:  Some of the call logs will allow you to investigate the ‘circumstances’ of 
the paging call and enable you to use the bottom window to look at each 
individual call in more detail: 
 

 
 

Some call logs are counts and these are presented as a list: 
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14.3 Creating a New Call Log Query 
 

1. From the View menu click Call Log Query then click Configuration.  
 
2. Right-click and click Add Query. 

 
3. Go to the bottom Window, under Query Name click on Filter 1 and type-in 

a suitable query name in place of the ‘Filter 1’ default.  Press Return to 
confirm. 

 
4. Under Query Type click on the option you require.  There are eight options 

to choose from, you may only select one: 
 

a. Filtered Log - Lists all calls stored in the call log database – similar to 
the Live Call Log. 

 
b. User Count - Counts the number of calls made to each user. 

 
c. Team Count - Counts the number of team calls within the database.  

Since a separate call is recorded for each team member, the actual 
number of calls to a whole team will be the team count divided by the 
number of members. 

 
d. DLC Count - Counts the number of calls made due to DLC input 

activation. 
 

e. Receiver Count - Counts the number of calls made to each receiver 
address. 

 
f. Device Count - Counts the number of calls made from each paging 

system device address. 
 

g. Speech Count - Counts the number of speech calls made from each 
paging system device address. 

 
h. Error Count - Counts the number of calls made, aggregated according 

to the call error number. 
 
5.  Adding Log Filter Details 
 

Having selected Query Type you can now apply a filter or filters, this 
enables you to set a range of parameters for more detailed archiving or 
analysis.  To select a filter or filters YOU MUST click one or more of the 
filter tick boxes or the filter will NOT be activated, then select the filter 
criteria: 

 
a. Start Date - Determines the start date to which calls will be included or 

archived in a query.  Click on the Date Field.  Click the Down Arrow 
Button then select the start date from the calendar. 
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b. End Date - Determines the end date to which calls will be included on 
archived in a query.  Click on the Date Field.  Click the Down Arrow 
Button then select the end date from the calendar. 

 
c. Duration - Specifies the number of days to include since the most 

recent paging call.  Enabling this filter automatically disables the two 
previous options.  Click on the Duration Field, type-in the number of 
days required then press Return. 

 
d. User - Specifies the number of calls made to a specific user.  Click on 

the User Field and type-in the user number, alternatively use the up 
and down arrows keys, press Return to confirm selection. 

 
e. Team - Specifies the number of calls made to a specific team.  Click on 

the Team Field and type-in the team number, alternatively use the up 
and down arrows keys, press Return to confirm selection. 

 
f. DLC - Specifies the number of calls made to a specific DLC.  Click on 

the DLC Field and type-in the DLC number, alternatively use the up and 
down arrows keys, press Return to confirm selection. 

 
g. Priority – This specifies the paging priority.  Only calls made with the 

specified priority will be included.  Click relevant tick-boxes to select 
appropriate priority. 

 
h. Paging Error - Specifies a paging error code, only calls made with the 

specified error code are included.  Click on the Paging Error Field and 
select the Error Type from drop-down list box. 

 
i. Receiver/Group - Specifies either a receiver number or a format group.  

Calls made to other receivers/format groups will be ignored.   Type-in 
the receiver or format group number, then press Return to confirm 
selection.  Note that for format groups this item is a three-character 
string of the form ‘nnC’ or ‘nCC’ or where nn is the format group base 
address for groups of 10 receivers, and n is the base address for 
groups of 100 receivers. 

 
j. Receiver Type  - This allows you to select a specific receiver type to 

which a call was made.  Click on the Receiver Type Field and select the 
Source Device from drop-down list box.   

 
k. Channels - Allows the selection of paging system channels on which a 

call was sent.  Only calls made on an exactly matching set of channels 
will be included.  Click the relevant tick-boxes to select Channel Type. 

 
l. Paging Service - Specifies the service flags for a particular call.  Only 

calls with paging flags exactly matching the selected flags will be 
included.  Click the relevant tick-boxes to select the appropriate Paging 
Services. 
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m. Source Device - Specifies the bus address of the device from which 
calls were made.  Only calls made from the specified device will be 
included, all others will be ignored.  Click on the Source Device Field 
and select the Source Device from drop-down list box.   

 
n. Speech Source - Specifies the bus address of the device used as a 

speech source for a call.  Only calls made with the specified speech 
source device will be included.  Click on the Speech Source Field and 
select the Speech Source from drop-down list box.   

 
6. Once you have created your customised call log you may view this in the 

normal way - From the View menu click Call Log Query then click on the 
newly created Call Log Query Name. 

 
Note:  While the call log data is stored and downloaded from the server, the 
query settings are only stored on the client computer, thus there is no ‘Update’ 
button.  The actual call data displayed for a query is, however, based on the 
complete call log. 



9261-7625 Issue 1 Page 106

14.4  Example - How to Create a New Query 
 

1. From the View menu click Call Log Query then click Configuration.  
 
2. Right-click and click Add Query. 

 
3. Click on Filter 1 and type-in the query name, e.g. March 2003 Paging 

Calls, then press the Return key to update. 
 

4. Go to Query Type and click the Filtered Log option. 
 

5. Go to Log Filter Details and click the Start Date tick box.  Click on Date 
Field then click the Down Arrow Button and select 1st March 2003 from the 
calendar. 

 
6. Click on the End Date tick box.  Click on the Date Field then click the Down 

Arrow Button then select 31st March 2003 from the calendar. 
 

7. The query has now been created. 
 

8. To review the query, from the View menu click Call Log Query then select 
the March 2003 Paging Calls query. 

 
Using this method you can analyse previous calls or set up a filter to capture 
calls made in the following month, quarter, 6-month period or year. 
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14.5 Editing a Call Log Query 
 

From the View menu click Call Log Configuration then click on the Call Log 
Query you require.  Go to the bottom window to change query and filter 
parameters.  This can be done in the same way as the described in Section 
14.3.   

 
Note:  You can edit and amend the query types options and log file filters as 
often as you require. 
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14.6 Deleting a Query 
 

1. From the View Menu click Call Log Configuration then click 
Configuration. 

 
2. From the top window and select the Query you wish to delete. 

 
3. Right-click then click Delete Query. 

 
4. Confirm the selection Yes or No. 
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15. USER, TEAM, SET & GROUP PAGING 
 

Management Client provides a facility for sending non-speech paging calls to 
users, teams and sets using the ‘Paging Console’ window. 
 
 

15.1 Sending a Paging Call 
 
1. To select a user, team, set or group number and to send a paging call you 

will need to select the Paging Console, you may either: 
 

a. From the View Menu click Paging Console.  To enter a user, team, set 
or group number click on the User, Team, Set or Group Button and 
enter the required number in the right hand column, or 

 
b. Click the Page button ( ) on the Standard toolbar.  To enter a user, 

team or set number click on the User, Team, Set or Group Button and 
enter the required number in the right hand column, or 

 
c. From the User Database, click the user you wish to page, right-click 

and select Page User, or 
 

d. From the Teams Database, right-click and select Page Team, or 
 

e. From the Sets Database, right-click and select Page Set. 
 

f. From the Groups Database, right-click and select Page Group. 
 

 
 
 

3. When a valid User, Team or Set has been selected the Paging Console 
will display full message details - Name, function, current status and 
message type etc. 
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4. Select a message: 
 

� To enter a Fast Alpha or CFA message, right click and select Fast 
Alpha Message you can either type-in the message number and press 
the Return key. Or 

 
� Click on the down arrow button and select the message from the list 

box. 
 
� For free format messages, right click and select Message, enter your 

message.  When sending a message to an alphanumeric pager you 
can select a Fast Alpha or CFA message and add extra text. 

 

 
 
 

5. To send the paging call, press one of the page buttons (circle ( ), triangle 
( ) or square ( ) for users and sets, or team page ( ) red button for 
team calls).  These will only be available when valid paging parameters 
have been entered and the Management Client is online. 
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15.2 Paging History 
 

The Paging Console maintains a history of the last 25 users, teams, sets and 
CFA messages paged: 
 
1. Select user, teams, sets or groups tick box 
 
2. Click the drop-down arrow – A list box of the last 25 calls to users, teams 

and sets will displayed: 
 

 
 
 
3. To examine the message history, select a user, team, set or groups, then 

click the Message box, then click on the down arrow to reveal the message 
history list box: 
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PAGING CLIENT 
 
 
1. A GUIDE TO THE PAGING CLIENT 
 

The Paging Client or Paging Operator may be installed on any networked PC 
and supports the following key features: 

 
� User, team, set and group paging 
� Search feature 
� The ability to set-up and edit system and personal groups 
� Call Scheduler – If enabled 
� The ability to set-up and edit the Call Scheduler 
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2. ACCESSING THE PAGING CLIENT 
 

 
2.1 Opening the Paging Client 

 
1. Click the Start button:  
 
2. Click Programs, click Access 3000 Sever Suite, click Paging Client: 

 

 
 

3. Select your Operator ID from the list, if activated enter the Password and 
click Login: 

 

 
 
4. The Paging Client will now be displayed: 
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2.2 Changing Passwords 
 

1. From the top left hand corner of the paging client screen, click the  icon. 
 
2. From the menu click Change Operator Password. 
 
3. Enter the current password, then enter the new password, then confirm the 

new password and click OK.  When you login you will now have to enter 
the password as part of the login sequence: 

 

 
 

Note:  If you wish to remove password protection, leave the Enter New 
Password and Confirm New Password boxes blank.  Click OK to confirm 
the selection.   
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2.3 Paging Client – Exit 
 
 
2.3.1 Logging Off 
 

1. From the top left hand corner of the screen click the  icon. 
 
2. You will now be asked to confirm the action, select Yes or No. 

 
3. At the Login Screen you may log-in under an alternative ID: 
 

 
 
 
2.3.2 Exiting the Paging Client 
 

1. From the top left hand corner of the screen click the  icon.  
 
2. From the list box click Close. 

 
3. You will now be asked to confirm the action, select Yes or No. 
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3. USER, TEAM, SET & GROUP PAGING 
 
 
3.1 User Paging 
  

The paging client has been designed for both mouse or keyboard operation: 
 

 
 

 
1. Press F1 for User Paging. 
 
2. Enter the Name or Number of the paging recipient and press the Return 

Key. 
 

3. In Recipient Details check the message type before entering text. 
 

4. Use the Return Key to toggle between Fast Alpha Message to send a 
pre-set message or Message to send a free format text messages.  Either 
select or enter the message or both. 

 
5. For user paging, depending on priority, press F7 = Square, F8 = Triangle 

or F9 = Circle to page.  
 

6. Access 3000 will then acknowledge the call.  Press the Return Key to 
continue. 
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3.2 Team Paging 
 
 To send a team call: 

 
 
 

1. Press F2 for Team Paging.  
 
2. Type in the team Name or Number and press the Return Key. 

 
3. Check the message type before entering the message text. 

 
4. Use the Return Key to toggle between Fast Alpha Message to send a 

pre-set message or Message to send a free format text messages.  Either 
select or enter the message. 

 
5. For team press F9 = Red Square.   

 
6. Access 3000 will then acknowledge the team call.  Press the Return Key 

to continue.  
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3.3 Paging a Set 
 

To send a paging call to a Set: 
 

 
 
 

1. Press F3 for Sets Paging.  
 
2. Type in the Set Number and press the Return Key. 

 
3. Check the message type before entering the message text. 

 
4. Use the Return Key to toggle between Fast Alpha Message to send a 

pre-set message or Message to send a free format text messages.  Either 
select or enter the message. 

 
5. For user paging, depending on priority, press F7 = Square, F8 = Triangle 

or F9 = Circle to page.  
 

6. Access 3000 will then acknowledge the Set call.  Press the Return Key to 
continue.  
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3.4 Paging a Group 
 
To send a paging call to a Group: 

 

 
 
 

1. Press F4 for Group Paging  
 
2. Type in the group Name or Number and press the Return Key. 

 
3. Check the message type before entering text. 

 
4. Use the Return Key to toggle between Fast Alpha Message to send a 

pre-set message or Message to send a free format text messages.  Either 
select or enter the message. 

 
5. For user paging, depending on priority, press F7 = Square, F8 = Triangle 

or F9 = Circle to page.    
 

6. Access 3000 will then acknowledge the team call.  Press the Return Key 
to continue.  
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4. QUICK & SIMPLE USER, TEAM SET OR GROUP SEARCH 
 

You can search for a user, team, set or group by either Name or Number by 
simply entering all or part of the name or number – where more than one entry 
matches the search string, the left/right arrow buttons can be used to jump 
between them.  Alternatively you can visually scroll through the list and select 
the appropriate entry by clicking the mouse.  The list can be sorted by clicking 
on the column headers, and the headers re-sized or rearranged by dragging 
them with the mouse. 
 
The paging client incorporates a powerful Advanced Search facility.  Press 
F6 or click the double arrow buttons to display the advanced search options. 
 

 
 
 

1. Use the Up and Down Arrow keys to select the search criteria, e.g. 
User name, User, Number, Transfer, First Name, Last Name etc. 

 
2. Press the Space Bar or click on the Tick Boxes to select the search 

items e.g. Job and Department: 
 

 
 
 

3. Type in the search criteria e.g. ENT and Surgeon, use the Page Up 
and Page Down to identify all ENT staff and Surgeons.  To make a 
selection press the Return Key to facilitate a paging call. 

 
Note:  In order for this feature to operate effectively full details of each 
user, team record etc., need to be entered into the system. 
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5. CREATE, EDIT & DELETE SYSTEM AND PERSONAL GROUPS 
 

Unlike team paging, which is reserved for critical, life-saving applications, each 
individual paging client can create their own less formal personal paging 
groups.   

 
 
5.1 Creating a New Group 

 
You may create two types of group, Personal Groups and System Groups.  A 
Personal Group is ‘personal’ and can only be created, edited and viewed by 
the person who initially created the group.  A System Group is more formal it 
can be seen by everyone but can only be edited people who have system 
group edit access rights. 
 
4. Press F4 for Group Paging 
 
5. Right click and select Add Group.  A new Group will be created. 

 
6. From Group Identifier select the following: 

 
a. Group – This is used to identify the Group.  Click the right hand column 

and enter the group name or number, e.g. Group 1, Secretaries, etc. 
 

b. Group Type – Click to select Personal or System Group 
 

5. From Group Details select the following: 
  

a. Name – If you wish to give the Group a further means of identification, 
click on the right hand column and enter appropriate, additional 
information.  

 
b. Function – If you wish to give the Group a function, e.g. Weekly Team 

meeting, click on the right hand column and enter the required function.  
 

c. Department – Enter department details as required.  
 

d. Select Group Information – Click-on the right hand column and type-in 
relevant details.  Please note all these fields are optional items only. 

 
6. Press the Return Key to accept these changes. 
 
7. Click Update. 
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5.2 Adding a User Member to a Group 
  
1. Press F4 for Group Paging. 
 
2. Click and select the required group. 
 

 
 
 
3. Right click and select Add User Member. 
 
4. From the list box click the required User, this will be added to the Group. 
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5.3 Adding a Group to a Group 
 

  
1. Press F4 for Group Paging. 
 
2. Right click and select the required group: 
 

 
 
 
3. Right click and select Add Group Member. 
 
4. From the list box click the required Group, this will be added to the 

selected group 
 

Note:  For a system group you can only add additional System Groups; 
you cannot add Personal Groups.  However, with a Personal Group you 
may add both Personal and System groups as sub-members. 

 
 

 
 
 
 



9261-7625 Issue 1 Page 124

5.4 Modifying a Group 
 

1. Press F4 for Group Paging 
 

2. Click on the group you wish to modify. 
 

3. Right click and select Modify. 
 

4. From Group Identifier select Group, you may change the name of the 
group only.  Click the right hand column and enter the group name or 
number, e.g. Group 1. 

 
5. From Group Details you may alter all relevant group information – Click 

the right hand column and enter relevant details.  Please note all these 
fields are optional items only. 

 
6. Press the Return Key to accept these changes. 

 
7. Click Update. 
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5.5 Deleting a Group 
 

1. Press F4 for Group Paging 
 

2. Click on the group you wish to delete. 
 

3. Right click and select Delete Group. 
 

4. From the dialog box click Yes the Group will now be deleted. 
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5.6 Deleting a Group User Member 
 

1. Press F4 for Group Paging. 
 
2. Select the group you wish to delete a user member from. 

 
3. Click on the User Member you wish to delete. 

 
4. Right click and select Delete Member. 

 
5. From the dialog box click Yes the User Member will now be deleted. 
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6. SCHEDULER 
 
Access 3000 Server also incorporates a call scheduling facility, integrated into 
the Paging Client, enabling you to enter and send a message at some future 
point-in-time.  Simply select the user, team, set or group then determine the 
time and message priority and Access 3000 Server will process the call at the 
pre-determined time. 
 
By pre-booking paging calls, Call Scheduler acts as a mobile diary reminding 
the recipient of appointments or actions that need to be undertaken on a one-
off or regular basis.  Calls can be scheduled at anytime, either on a daily (1 to 
7 days), weekly, monthly or a yearly basis.    
 
Call Scheduler though integrated into the Access 3000 Server is in fact a 
separate product and can only be initiated via its own unique authorisation 
code.  This is supplied separately from the Access 3000 Server authorisation 
code. 
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6.1 Scheduled Call List 
 
The scheduled call list appears in the paging and management clients, and 
lists some or all of the scheduled calls on the system: 
 

 
 
 
The list can be sorted according to any column.  When sorted according to call 
time (the default), the list shows calls in the order in which they would occur on 
any given day.  The icon and colour used in each row in the table is governed 
by the current state of the call: 

 
Colour Description 
Green Call scheduled to occur today 
Normal/White Call will not occur today 
Grey Scheduled call is disabled 
Light blue The “next” scheduled to occur (although this may not be today, or 

may be disabled) – this colour is merged with the above colours. 
Red The last time the call went out, there was an error – the call was not 

sent 
 
 

Icon Description 
 Normal scheduled call 

 The last time the call went out, there was an error – the call was not 
sent 

 
The next call to be sent is indicated with a small yellow arrow (e.g. ), calls 
not due to be sent today will have a lighter icon (e.g. ), and disabled calls 
are marked with a red cross (e.g. ). 
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6.2 Creating a Scheduled Call 
 

1. Press F5 for Schedule. 
 
2. Right click and select Add Scheduled Call. 

 

 
 
 

3. From Recipient Type click ‘Please select a recipient…’ From the list box 
select Page User, Page Team, Page Set or Page Group. 

 
4. From Recipient click ‘Please select a recipient…’ From the list box select 

the appropriate User, Team, Set or Group. 
 

5. From Paging Message enter the message type, either click Fast Alpha 
Message, then click the down arrow and to select a pre-set message or 
click Message and enter your message. 

 
6. From Page Level click on the Call Priority and select the priority from the 

list box. 
 

7. From Schedule Details you may determine the frequency and duration 
period of the scheduled call.  A scheduled call can be made Once only, 
Daily, Weekly, Monthly or even on a Yearly basis:   

 
a. Once Only 
 

1. From Type click the right hand column and select: Once from the 
list box. 

 
2. From Time (00:00:00) enter the time you wish the scheduled call to 

be sent. 
 

3. From Date click the right hand column, click on the down arrow 
button to select the date from the Calendar from which the 
scheduled calls should commence. 
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b. Daily 
 
1. From Type click the right hand column and select: Daily from the 

list box. 
 
2. From Time (00:00:00) click and enter the time you wish the 

scheduled call to be sent. 
 

3. From Days use the drop-down list or tick boxes to select the days 
on which you wish the scheduled call to be sent. 

 
4. From Start Date click the right hand column.  Now click on the 

down arrow button to select the date from the Calendar from which 
the scheduled calls should commence. 

 
5. If you wish the scheduled calls to terminate at a given point in time, 

click the End Date tick box.  Click the right hand column.  Now click 
on the down arrow button to select the end date from the Calendar. 

 
c. Weekly 

 
1. From Type click the right hand column and select: Weekly from the 

list box. 
 
2. From Repeat click the right hand column and use the Up and 

Down arrow keys to select the frequency of calls: 1 for ‘Every 
week’, select 2 for ‘Every 2 weeks’ etc. 

 
3. From Time (00:00:00) click and enter the time you wish the 

scheduled call to be sent. 
 

4. From Day of Week click the right hand column, from the list box 
select the day to which the call should be sent 

 
5. From Start Date click the right hand column.  Now click on the 

down arrow button to select the date from the Calendar from which 
the scheduled calls should commence. 

 
6. If you wish the scheduled calls to terminate at a given point in time, 

click the End Date tick box.  Click the right hand column.  Now click 
on the down arrow button to select the end date from the Calendar. 
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d. Monthly 
 

1.  From Type click the right hand column and select: Monthly from 
the list box. 

 
2. From Repeat click the right hand column and use the Up and Down 

arrow keys to select the frequency of calls: 1 for ‘Every month’, 
select 2 for ‘Every 2 months’ etc. 

 
3. From Time (00:00:00) click and enter the time you wish the 

scheduled call to be sent. 
 

4. From Day of Month click the right hand column; from the list box 
select the day-of-the-month to which the call should be sent. 

 
5. From Start Date click the right hand column.  Now click on the down 

arrow button to select the date from the Calendar from which the 
scheduled calls should commence. 

 
6. If you wish the scheduled calls to terminate at a given point in time, 

click the End Date tick box.  Click the right hand column.  Now click 
on the down arrow button to select the end date from the Calendar. 

 
e. Yearly 

 
1. From Type click the right hand column and select: Year from the list 

box. 
 
2. From Repeat click the right hand column and use the Up and Down 

arrow keys to select the frequency of calls: 1 for ‘Every year’, select 
2 for ‘Every 2 years’ etc. 

 
3. From Time (00:00:00) click and enter the time you wish the 

scheduled call to be sent. 
 

4. From Start Date click the right hand column.  Now click on the down 
arrow button to select the date from the Calendar from which the 
scheduled calls should commence. 

 
5. If you wish the scheduled calls to terminate at a given point in time, 

click the End Date tick box.  Click the right hand column.  Now click 
on the down arrow button to select the end date from the Calendar. 
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8. From Scheduled Call details: 
 

a. From Name enter the name by which you wish to refer to the schedules 
call. 

 
b. From Notes enter any notes you may require when referring to the 

scheduled call. 
 
c. From Call Enable click the right hand column and select Disabled if 

you wish to temporary cancel the scheduled call.  The icon  will then 
be display in the main Schedule window  

 
d. From Edit click the right hand column and select ‘Everyone’ if you 

require all Operators who have access to this facility to amend or 
modify a scheduled call. 

 
e. From Follow Transfer click the right hand column and select Don’t 

Transfer if you do not want the scheduled call to follow the transfer 
chain or Follow Transfer if you wish the call to follow the transfer 
chain. 

 
9. When completed click the Update record button. 
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6.3 Modifying a Scheduled Call 
 

1. Press F5 for Schedule. 
 
2. Click the scheduled call you wish to amend. 

 
3. Right click and select Modify Scheduled Call. 

 
4. See Section 6.1 and amend as necessary. 

 
5. When completed click the Update record button. 
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6.4 Deleting a Scheduled Call 
 
1. Press F5 for Schedule. 
 
2. Click the scheduled call you wish to amend. 

 
3. Right click and select Delete Scheduled Call. 

 
4. You will now be asked to confirm the action, select Yes or No. 
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